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Introduction

Welcome to the Ingham Institute Brand Guidelines

This document outlines the positioning, the visual identity and design guidelines for the Ingham Institute for Applied Medical 
Research.

The contents of these guidelines cover all elements of the brand required for its consistent and most expressive application to 
reflect the scope of our research, the expertise of our people and the world-class facilities at the Ingham Institute.

The guidelines have been designed to support internal and external partners to ensure consistent and effective communication 
from the Ingham Institute on a local and global scale. These tools are designed to be applied across a wide range of uses while 
retaining its visual integrity and impact.

If you are uncertain about how to apply any aspect of the brand and visual identity please contact the Marketing Team on 02 
8738 9118 or email marketing@inghaminstitute.org.au.

Final authority on how to apply the brand guidelines lies with the Marketing Department.

Inspiring health. Transforming care. 
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The Ingham 
Institute Brand
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The Ingham Institute conducts world-class medical research within state-of-art facilities located in 
South West Sydney.

The Institute is home to over 300 researchers, scientists and medical professionals who are focused on exploring new medical 
approaches across five research streams: 

• Cancer Research

• Clinical Science Research (comprising Cardiovascular Disease, Diabetes and Infectious and Inflammatory Diseases)

• Population & Health Services Research

• Injury and Rehabilitation Research

• Mental Health. Research

The Institute has a unique partnership with the South Western Sydney Local Health District (SWSLHD), Western Sydney 
University (WSU) and University of New South Wales (UNSW), working in collaboration to improve health through community-
driven medical research.

All of the Institute’s medical research programs have a translational focus – visually demonstrated through our logo symbol – 
from bench to bedside. 

This means that results from the laboratory are transformed into direct health benefits in the form of new treatments and 
standards of care for local, national and international communities hence 'Applied Medical Research' in our logo.

The Ingham Institute prides itself on our commitment to applying our research to inspire health and transform care.

One Team. One Brand.

Inspiring health. Transforming care. 
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Our Heritage

The Ingham Institute has come a long way since its 
inception in 1996 and continues to work towards medical 
breakthroughs that will directly benefit the community  

of South West Sydney, Australia and beyond.

“The medical research work we do here 
not only benefits my local community in 
South West Sydney, but because of the 
mix of people we have here, it has real 
benefits for everyone.”

BOB INGHAM AM
FOUNDING BENEFACTOR

“And, while medical research is a long 
term project that requires hard work and 
dedication, Ingham Institute researchers 
are, right now, at the forefront of 
discovering new treatments and methods 
of care for common health conditions to 
help save lives and improve life.”

PROF. MICHAEL BARTON OAM
RESEARCH DIRECTOR
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Timeline

1996
The Ingham Institute’s founding 
benefactors, Jack and Bob Ingham 
of Inghams Enterprises, send a letter 
of commitment to establish and 
support the Ingham Institute.  

2012
The Ingham institute is officially opened by the Prime Minister of Australia, 
the Hon. Julia Gillard MP. The building is home to 30 research groups and 200 
researchers.

Respiratory medicine is awarded AUD $2.4 million over four years from the 
NHMRC for studies into understanding and ameliorating the human health 
effects of exposure to air pollution.

Our Palliative Care research unit receives AUD $1.5 million from the 
Commonwealth Department of Health and Ageing.

Our Gastro–intestinal viral oncology research group is the first group in 
the world to hypothesise and prove that high risk human papillomavirus 
is strongly associated with Barrett’s Dysplasia and Oesophageal 
Adenocarcinoma.

2009
Ingham Institute is successful in 
its application for $46.9m from the 
Federal Government. 

2010
Deputy Prime Minister Julia Gillard 
and Premier of NSW Kristina 
Keneally turns the first sod to 
officially open the new construction 
site.The Institute’s flagship MRI-
Linac cancer therapy equipment 
program receives initial Government 
funding.

2011
Construction of the Institute’s new 
main building begins.

The Institute’s new identity is 
launched: Ingham Institute for Applied 
Medical Research.

Psycho-oncology research group completes the development of the following 
Coping-Together resources to assist couples facing cancer to cope.

Prof. John French is co-investigator on an AUD $2.3 million NHMRC grant 
investigating measures to prevent serious adverse events for patients  
following angiography.

Simpson Centre receives over AUD $2 million in competitive grant funding for  
its work into emergency department reviews.

A/Prof Grahame Simpson, Brian Injury & Rehabilitation Research Group leader,  
is co-principal investigator for a major AUD $1million dollar grant from the  
United States Department of Defence's Military and Suicide's Research 
Consortium military and suicide research consortium to trial Window To Hope 
with brain-injured us military veterans.

The MRI-Linac research bunker room is completed.

Inspiring health. Transforming care. 
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2013
The Institute’s Clinical Skills and Simulation Centre officially opens. The 
centre is a fully simulated training hub for researchers, students, nurses 
and clinicians from the South Western Sydney Local Health District 
(SWSLHD), the University of Western Sydney (WSU) and University of 
New South Wales, Sydney (UNSW).

Our Pathway to Success program is launched. The program is aimed at 
bringing careers in health services and medical research to the interest 
and attention of year 10 and 11 high school students.

Ingham Institute becomes the home to NSW's first-ever circulating 
tumour cells (CTC) facility, specialised cancer scanning technology that 
measures single cancer cells in the small blood sample of a cancer patient.

Mental Health under the guidance of Professor Silove wins AUD $10.5 
million grant over five years for translating science into better post-
traumatic mental health program.

The Insitute's Whitlam Orthopaedic Research Centre (WORC) 
establishes the first, national Arthroplasty Clinical Outcomes Registry  
(ACORN) to improve the quality and effectiveness of arthroplasty 
surgery by monitoring, evaluating and reporting the clinical outcomes.

The Institute's Maternal Early Childhood Sustained Home-visiting 
(MECSH) program implemented throughout NSW, VIC, TAS, South Korea 
and the UK.

The Clinical Trials Unit is established at the Institute.

Prof. Valsa Eapen, Mental Health Research Group, publishes world-first 
study of the efficacy of the Early Starter Denver Model for children with 
autism.

2014
The Ingham Institute’s cancer research community panel is  
established to provide an opportunity for community members to learn 
about and provide active input into the cancer research projects being 
developed at the Institute. 

South Western Sydney Research Hub is established and brings together 
health, research and health education entities in South-Western Sydney. 

The inauguration of the Ingham Institute’s Research Director’s PhD 
Scholarship Program.

Centre for Oncology Education Research Translation (CONCERT) is 
born as a result of a significant AUD $6.5 million grant from Cancer 
Council NSW, is a multi-institutional consortium that brings  
together 200+ professional members spanning all aspects of cancer 
research, diagnosis, treatment and care.

The CONCERT Biobank for cancer tissue is established.

The inaugural Thomas Ashworth CTC Symposium launched.

Dr Tara Roberts awarded the Cancer Institute NSW's Future Research 
Leader Fellowship with a value of AUD $1.2 million over five years 
investigating the role of inflammation across a range of diseases.
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2015
The Institute opens level five and welcomes the Immune Tolerance group.

Associate Professor Meera Agar drives a world-first medical cannabis 
clinical trial.

Gastro-Intestinal Viral Oncology Group’s new study confirms HPV and 
P53 as definitive markers for the development of oesophageal cancer.

The Institute's Maternal Early Childhood Sustained Home-visiting 
(MECSH) program spreads its wings to the USA.

The Brain Injury & Rehabilitation Research Group is awarded AUD $1.2 
million grant from the NSW Government to establish a return-to-work 
program for people with brain injury.

The Institute’s Pancreatic Research Group leader Prof Minoti Apte 
is the first-in-the-world to develop a method to isolate and culture 
pancreatic stellate cells (PSCS), a technique which provided a much 
needed research tool for studying the pathogenesis of pancreatic 
fibrosi.

The MRI-Linac’s linear accelerator and Tesla ex-clinical MRI are 
installed; first beam-on image of the first prototype system.

2016
Installation of Zeiss Gemini SEM500 3D Electron Microscope that 
allows a 3D view of cancer cells using real human tissue in order to 
develop new treatments – the only one of its kind in a research institute.

Ian Potter Foundations grant is awarded for the purchase of a Licor 
Odyssey imaging system to identify more disease sub-types and 
perform more accurate measurement of pathway activity in cells, 
enhancing our understanding of the disease biology. 

The MRI-Linac’s split-bore magnet is installed.

2017
The Ingham Institute become members of the SAX Institute, a national 
leader in promoting the use of research evidence in health policy.

The Ingham Institute becomes a partner of the Sydney Partnership for 
Health, Education, Research & Enterprise (SPHERE). SPHERE is based 
at the Institute.

The Institute partners with Franklin Women for their Mentoring  
Women Program that supports high-potential women in health and 
medical research careers progress into leadership positions, retaining 
their skill in the sector.

The MRI-LINAC research bunker is officially opened by the Assistant 
Minister for Industry, Innovation and Science , the Hon. Craig Laundy MP

MRI-Linac achieves successful integration of all components of the 
split bore MRI; first in-line beam on image, first human images and  
real-time moving graphics. The program is awarded a further $7 million 
until 2022 from NHMRC.

The Ingham Institute launches new website

The Institute launches new vision statement:  
Inspiring heath. Transforming care.

ELECTRON TREE 
SEPTEMBER 2015
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Our Vision

• Inspiring and transforming are active and 
visionary words.

• Health and care represent the broad journey of 
wellbeing that guides our research.

• Inspiring health: highlights the Ingham Institute’s 
role in influencing health before, during and after 
illness.

• Transforming care: communicates the bedside 
to bench research model that informs our 
researchers and strategic partnerships .

• Inspiring health' is presented in a light font 
with 'Transforming care' progressing to a 
bold font. This intentional style of typography 
demonstrates the journey of wellbeing and 
highlights the Institute's origins and emphasis on 
transforming health care services and systems.

Inspiring health. Transforming care. Our strategic network of medical research centres of 
excellence, produce world-class insights and discoveries 
for application to health care services and systems, 

transforming community wellbeing locally and globally. 

• World-class insights and discoveries: the quality and progressive 
nature of the research carried out at the Ingham Institute is 
recognised around the world.

• Health care services and systems: from our origins of supporting 
Liverpool Hospital and South West Sydney Local Health District, the 
Ingham Institute is specifically dedicated to research that can be 
applied to improving the services and systems across our health 
network.

• Locally and globally: South West Sydney has become a hub for 
medical research aimed at improving the health and wellbeing for 
the local community, which is a unique microcosm representing the 
whole of Australia and beyond. 

Our Mission
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FUNCTIONAL: Our shared vision and strategy; Financial acumen and support; Risk management; Collaborative culture; Information and education; State-of-the-
art facilities; Governance and administration; Career pathways; Improved health, improved quality of care, reduced costs of health, less burden on health 
system.
EMOTIONAL: Comfortable and at ease, confident and assured, inspired and impressed, supported, safe and hopeful.

VALUES
The code by which the brand 
lives. Rules of the game. Hire and 
fire on these values.

CULTURE/PERSONALITY
TONE OF VOICE
Human characteristics that set the 
brand’s tone, feeling, behaviours.

PROOF POINTS
Tangible: evidence based reasons 
to believe.

VALUE PROPOSITION
The value the brand offers the 
customer, the problem the brand solves, 
what customer need does it satisfy.

BRAND VISION
The inspiration, reason for being.

BENEFITS
Functional: what one gets 
from the brand.
Emotional: how the brand 
makes one feel.

© Copyright Brandswell Worldwide

Applied medical research to innovate health care systems and services by supporting and enabling our strategic partners to 
inspire health and transform patient care, creating robust, healthy thriving communities, locally and globally.

World First Achievements
• Beam On MRI-Linac footage from split magnet
• Clinically validated suicide prevention program for patients after a 

traumatic brain injury
• Method to isolate and culture pancreatic stellate cells
• Maternal Early Childhood Sustained Home-visiting program 

(MECSH)
200+ Clinical & Surgical Trials 

• Phase 1 human clinical trial with Liverpool Hospital 
• Surgical training program for early career surgeons

Talent 
• 300 researchers, over 50% are practicing clinicians
• 93 PhD students from four eminent universities

Australia First Equipment 
• Home of the Australian MRI-Linac
• Cell Separator and Cell Picker used for Circulating Tumour Cell 

(CTC) blood test development

RELEVANT: Our work and relationships are embedded in being relevant to the community and partners we serve.
INTEGRITY: We are committed to transparency and the truth in our vigilance to building trusted relationships.
AMBITIOUS: We are bold in our belief and knowledge that research can and will change lives, locally and globally.
IMPACTFUL: We measure our work based on the immediacy and impact of its translation to health care delivery, health systems and healthy lifestyles.
INCLUSIVE: We believe in health equity for all. Our research is directed to the areas of health that carry the greatest burden for the majority of our community.

Brand Strategy 

Inspiring health. Transforming care.

DOWN TO EARTH
• Approachable
• Sensible
• Level headed

COLLABORATIVE
• Cooperative
• Working 

together
• Shared 

outcomes

PROFESSIONAL
• Competent
• Experienced
• Qualified
• Skillful
• Learned

ADAPTIVE
• Flexible
• Robust

INNOVATIVE
• Original
• Inventive
• Cutting-edge

ASTUTE
• Savvy
• Sharp
• Intelligent
• Clever
• Knowing

RESPECTFUL
• Polite
• Considerate
• Humble
• Considerate

Sate-of-the-art Facilities
• Correlative Microscopy Facility (Carl Zeiss LSM 800, Carl Zeiss  

GeminiSEM 300)
• Clinical Skills Simulation Facility (Simluation Labs, dV-Trainer, 

Suite of SimMan mannequins, Anatomage Table)
• Genome Sequencing Facility (Ion Torrent)
• South West Sydney Human Tissue Biobank
• Clinical Trial Facilities

Formal Affiliations
• South Western Sydney Local Health District (SWSLHD)
• University of New South Wales, Sydney (UNSW)
• Western Sydney University (WSU)

Peer Reviewed Publications: 170+ p/a and growing
Grant Success: 85% growth in NHMRC funding since 2011
Philanthropic Impact

• 100% of funds donated directly support research at the Institute

Brand Strategy
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Voice and tone
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Our Tone of Voice

The Ingham Institute has a broad range of audiences ranging from researchers, medical 
professionals, partners and the general public.  

Equally as important to how we are visually represent our brand, we also need to engage the audience through a consistent 
tone of voice in our words. We need to speak to each audience a little differently, however our tone of voice should reflect our 
core values and vision to inspire health and transform care.

Welcoming

The Ingham Institute is founded by the community for the 
community. Our communications must reflect that the 
Ingham Institute is accessible to everyone and not limited to 
the medical community.

Engaging

Our language is intelligent yet down-to-earth. The Ingham 
Institute shares our expertise and insights by translating 
complex and high-level research into transcript that is 
relatable to a non-medical community. 

Innovative

Our tone is ambitious and must illustrate that the Institute  
is at the forefront of medical research and pioneering 
medical equipment and technology. 

Translational

We must communicate the impact and reach of our 
research and its applications into the community through 
health care delivery, health systems/programs and healthy 
environments.

Relevant

Our work and relationships are embedded in being relevant 
to the community and the partners we serve. The language 
should depict our commitment to transform treatment of the 
key conditions in South West Sydney and beyond.
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Ingham Institute 

Refer to the organisation only as the Ingham 
Institute. Never use any other abbreviations, such as: 
The Ingham, Ingham, Ingham’s, II 
 

Language 

• People, Research Groups and Intellectual 
Property: Refer to research conducted at the 
Ingham Institute in the first instance. 
Example: Circulating Tumour Cell research 
condected at the Ingham Institute

• For Facilities, Equipment and Resources: Refer to 
the Ingham Institute’s (insert word here)’s.  
Example: 3D Electron Microscope...

• Refer to ‘our research’ and ‘our facilities’.  
Not ‘the research’ or ‘the facilities’.

• When referring to the Institute, the ‘I’ must always 
be capitalised. Example: the Institute

Funding 

• In community-focused communications, avoid 
mentioning any dollar amounts.  
Example: newsletters, newspapers, Facebook

• In industry-based communication, it’s acceptable 
to mention dollar amounts. 
Example: Annual reports, Industry publications, 
Twitter

Hierarchy of entities 

1. The Ingham Institute
2. Five streams, plus clinical trials
3. Groups are within the streams
4. Projects/Programs (specific projects that  

appear on the Group microsite)

‘Stream’ and ‘Group’ are not interchangeable – 

this is because streams are made up of multiple 

groups and teams 

For example, the XYZ Research, Education and 
training Unit works within the ABC stream at the 
Ingham Institute. The XYZ Group/Team has over  
35 PHD students who are actively working across 
100 programs/projects.

Projects and programs are interchangeable 

No other term can be used in the place of 

‘Stream’ 

Stream refers to the five groups of research focus. 

Always ensure the appropriate stream is included:

• Cancer Research
• Clinical Sciences Research
• Population & Health Sciences Research
• Injury and Rehabilitation Research
• Mental Health Research

In the first instance, use the technical group 

name and in subsequent references refer to a 

group of people at the institute as ‘team’ to 

convey a collaborative and friendly tone 

To appear accessible, conclude all 

communications with the following statement: 

‘To learn more about [insert specific reference]  
at the Ingham Institute, or to book a tour,  
contact us today on 1300 66 55 41 or  
research@inghaminstitute.org.au’

Best Practices



15

Copy Guidelines

Language The organisation is referred to as the Ingham Institute for 
Applied Medical Research. In the first instance, refer to 
the organisation as the Ingham Institute or the Institute.

Never use The Ingham, Ingham, Ingham's, II

Refer to ‘our research’ and ‘our facilities’, rather than  
‘the research’

Spelling Australian English

Contractions Contract all words where possible:

• We will = we’ll
• You are = you’re
• It is = it’s
• That is = that’s

Use plain English Use plain language:

• Purchase = buy
• Receive = get
• Require = need/want
• Represents = is/are
• Assist = help
• Acute = critical (except in scientific materials)
• Novel = innovative / new (except in scientific materials)
• Intervention = treatment (except in scientific materials)

Avoid abbreviations • Use ‘and’ not ‘&’ (except in navigation and  
page headers)

• Use ‘that is’ not ‘i.e.’
• Use ‘for example’ not ‘e.g.’
• Use ‘and so on’ not ‘etc.’
• Use full month names: ‘December’ not ‘Dec’

Avoid vague terms • Use ‘approximately’ not ‘about’
• Use ‘almost’ not ‘roughly’
• Use ‘nearly’ not ‘around’

Avoid passive voice Bad: ‘The business is improved by the new system’ 
Good: ‘The new system improves the business.’

Acronyms Always use the full title in the first instance. Only use an 
acronym where space or repetition suggests it.

Case Sentence case to be used for page names, sub-headers 
and links. Title case to be used for proper nouns only

Currency format A$XX

Dash Hyphen ( - ): Use to hyphenate words or show range. For 
example, ‘2-5TB’, ‘May 6-7’ 

En dash (–): can be used for explanation

Date format 13 May 2017

Full stops Full stops are not required at the end of headers,  
sub-headers or bulleted sentences.

Links Contextual links should be used as well as (or instead of) 
end-of-article ‘Read more’ links.

Contextual keyword hyperlinks should be used rather 
than featuring the full URL. For example: ‘a recent Twitter 
report reveals…’ rather than ‘a recent report on http://www.
twitter.com reveals…’

Numbers Use numbers from 1-9, after that use numerals instead of 
words for numbers.

Percent Use the symbol ‘%’ with a numeral, without a space: ’97%’.
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Brand assets
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What our symbol represents

Our symbol represents the transformational nature of our research.

A uniform shape has been folded to create three distinctly different shapes that represent 
the inter-connectivity between “Bench to Bedside to Community” and the mutually 
dependent partnership between the universities, its health authority and the community.

The resulting transformation symbol is distinctive, daring, bold and unreservedly 
unorthodox. Its sculptural quality suggests an Institute prepared to take a three dimensional, 
or 360 degree, look at conventional assumptions and data.

Our Transformation Symbol
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POSITIVE LOGO

Always use the main logo in horizontal format.

REVERSE FORMAT

The reverse logo may be used on a dark 
colour background.

LINE ART FORMAT

A line art version can be used in a single colour black 
or white only when the full colour version cannot be 
used due to printing or media limitations.

Brand Logo Formats

Our logo is made up of two key elements, the 
Transformation symbol, Ingham Institute and 
Applied Medical Research.

They must NOT be used independently of each other.
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Brand Logo - Clear Space, Minimum Size

Clear space

There should be a minimum clearance between the 
logo and other elements. To properly stage the logo, 
the minimum distance should be ‘1/2 X’ which is 
equivalent to half the height of the transformation 
symbol. 

Minimum size

The minimum width of the logo must be at least 
180 pixels for digital applications or 40mm for 
print. Do not use the logo at a size less than this as 
reproduction may become problematic. 

1/2 X

1/2 X

1/2 X

1/2 X

X
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Brand Logo - Stacked

The stacked logo is designed for use where  
space is limited.

These can be used in the following:

• Online

• Mobile responsive logo

• Promotional items

FACEBOOK LINKEDINTWITTER
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Brand Logo Usage - Misuse Examples

Ingham Institute
Applied Medical ResearchX

X
X

X

X

X

X
X

Typeset the wordmark

Encase the logo in a shape

Add effects like shadows 
to the logo

Use a pattern within the logo

Rearrange elements of the logo

Place the logo over busy or 
distracting backgrounds,

Alter the logo colour except 
as specified

Compress, stretch or 
distort the logo

Place the logo over 
background with 

insufficient contrast

X
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Gradient Background and Vision

Inspiring health. Transforming care.
1/2 X

1/2 X

1/2 X

1/2 X

A key visual element is the gradient background and 
tranformation symbol This dynamic combination of 
texture and tone create a strong visual reference to 
the brand logo. 

Tips 

DO

• Tagline should only be in white, right aligned and 
placed on the bottom right hand corner in the 
darkest blue part of the gradient

• Single line is preferred, however in instances 
where space is limited, the vertical lock up may 
be used  

DON'T

• Use any other gradient mixes except for those 
that have been specified

Resources 

Available via the Ingham Institute intranet.  
<Link>

GREEN - LIGHT BLUE GRADIENT 

Please refer to the colour section for more 
detailed information about our gradients. 

TRANSFORMATION SYMBOL

The symbol should be applied as an Overlay effect at 100% 
Opacity over the gradient, and have a Linear gradient filter. 

X

How to create gradient background (for professional use only) 
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Gradient Colour

GREEN TO LIGHT BLUE GRADIENT DARK BLUE TO LIGHT BLUE GRADIENTWe use two gradients in our visual system.  
Gradients should only be used in a horizontal 
direction.

Tips 

DO

• Set gradients to a linear direction 

DON'T

• Never use gradients at an angle
• Do not mix different gradient directions in a single 

layout. When there are repeating layout elements 
across several pages, make sure all the gradients 
are the same type and direction. 

Resources 

Gradient source files are available for download from 
Ingham Institute intranet. <Link>

GREEN TO LIGHT BLUE GRADIENT COLOUR STOPS DARK BLUE TO LIGHT BLUE GRADIENT COLOUR STOPS

PANTONE© 300
C100 M40 Y0 K0
R0 G125 B197
#007DC5

PANTONE© 299
C70 M15 Y0 K0
R39 G170 B225
#27AAE1

PANTONE© 381
C25 M0 Y100 K0
R203 G219 B42
#CBDB2A

PANTONE© 299
C70 M15 Y0 K0
R39 G170 B225
#27AAE1



24

Inspiring health. Transforming care.

Inspiring health.  
Transforming care.

Inspiring health. Transforming care.
Inspiring health. 

Transforming care.

Gradient Background and Vision Examples
NARROW LANDSCAPE PORTRAIT

BROAD LANDSCAPE

STRIP LANDSCAPE
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Typography - For Professional Publications

SUBHEADS

Use Accord Alternate Bold for subheadings in PMS 300 Blue.

Accord Alternate Bold
ABCDEFGHIJKLMNOPQRSTUVWXYZ 
abcdefghijklmnopqrstuvwxyz 
1234567890 (@#$&?!) 

HEADINGS

Use Accord Alternate Medium for headings in PMS 432 Grey.

Accord Alternate Medium 
ABCDEFGHIJKLMNOPQRSTUVWXYZ 
abcdefghijklmnopqrstuvwxyz 
1234567890 (@#$&?!)

Headings and Subheads

Accord Alternate is our corporate typeface 
and is to be used for large headlines and 
subheads. It is important that most corporate 
material is set in Accord Alternate. 

Tips 

• Tracking for headlines work well at 20 
• Title and sentence cases are preferred 
• Only use ALL CAPS in small instances 

such as labels and charts 
• Always set ® and ™ as superscript

Resources 

The Accord Alt font may be purchased for use from: 
http://new.myfonts.com/fonts/soneri/accord-alt/
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Typography - For Professional Publications

PRIMARY BODY COPY

Use Roboto Light for body copy in PMS 432 Grey.

Roboto Light
ABCDEFGHIJKLMNOPQRSTUVWXYZ 
abcdefghijklmnopqrstuvwxyz 
1234567890 (@#$&?!)
SUPPORTING WEIGHT

User Roboto Medium for emphasis in smaller applications such as subheads,  
captions, tables and charts.

Roboto Medium
ABCDEFGHIJKLMNOPQRSTUVWXYZ 
abcdefghijklmnopqrstuvwxyz 
1234567890 (@#$&?!)

Body Copy

Roboto will serve as the primary typeface for body 
copy. Roboto is available as a Google webfont. 

Tips 

• Tracking for body copy work well at 10
• Always set ® and ™ as superscript
• When you need a softer font colour, use 50% of 

the PMS 432 Grey.

Resources 

Roboto is available for download from Google Fonts. 
https://fonts.google.com/specimen/Roboto



27

Typography - For Internal Use

SUPPORTING WEIGHT FOR TABLES, CAPTIONS AND CHARTS ONLY

Tahoma Bold
ABCDEFGHIJKLMNOPQRSTUVWXYZ 
abcdefghijklmnopqrstuvwxyz 
1234567890 (@#$&?!)

DEFAULT WEIGHT

Tahoma Regular
ABCDEFGHIJKLMNOPQRSTUVWXYZ 
abcdefghijklmnopqrstuvwxyz 
1234567890 (@#$&?!)

Where Accord Alternate is not available, Tahoma 
should be used as a substitute. These cases may 
include internally produced documents and digital 
applications such as HTML emails, Word documents, 
or digital presentations.

The default weight is Tahoma Regular. 

Where Tahoma is not available on MacOS,  
the preferred font is Geneva. 

Tips 

DO 

• Create typographic hierarchy with font size
• Use Tahoma Bold only for emphasis in smaller 

applications such as subheads, captions, tables 
and charts

• Always set ® and ™ as superscript

DON'T

• Never use Tahoma Bold for main headings
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Lorem ipsum dolor sit amet, consectetur 
adipiscing elit. Mauris at iaculis mauris. 
Curabitur posuere at odio eu blandit. Nulla ligula metus, mollis 
in facilisis vitae, pretium sed tellus. 

Curabitur malesuada eget purus viverra venenatis. Vestibulum sagittis magna id vulputate 
viverra. Interdum et malesuada fames ac ante ipsum primis in faucibus. Praesent pretium 
ipsum non dolor auctor, id consequat nisi mattis. In iaculis odio arcu, in malesuada enim 
facilisis et. Maecenas feugiat orci nibh, nec tempus diam pharetra sed. Ut id tellus id nulla 
consectetur egestas. Vivamus metus enim, elementum eu maximus in, commodo ac augue.

Nulla facilisi. Suspendisse potenti. Vivamus vitae cursus metus. Etiam metus sapien, 
lacinia sit amet pellentesque non, faucibus eget risus. Curabitur risus turpis, consequat 
at mollis in, egestas quis diam. Donec et viverra purus. Aliquam cursus semper nibh in 
condimentum. Morbi accumsan lacinia condimentum. Cras pretium ante mi. Ut justo erat, 
pulvinar id fermentum eget, viverra eu purus. Suspendisse auctor faucibus arcu, in dictum 
lorem euismod a. Integer semper odio a leo pretium, sit amet malesuada nunc sagittis. Cras 
convallis mollis urna ut vulputate.

In nec tellus sem. Donec vel mi velit. Etiam at varius nulla. Donec aliquam nunc at nisl eleifend malesuada. Mauris 
orci arcu, iaculis vitae fringilla vitae, cursus eu purus. Ut lacinia nibh sed lectus vulputate, nec suscipit nisi mattis. In 
sed enim dolor. DOCUMENT EXAMPLES

HEADLINE

Accord Alternate Medium
PMS 432 Grey

SUBHEAD

Accord Alternate Bold
PMS 300 Blue

LEGAL COPY

Roboto Light
60% PMS 432 Grey

BODY COPY

Roboto Light
PMS 432 Grey

Inspiring health. Transforming care. 

The Ingham Institute is a world class research precinct 
located at Liverpool Hospital that houses a team of 200 
researchers who are at the forefront of some of the most 
exciting discoveries relating to key disease areas affecting 
the local community and Australia at large. 

• The Ingham Institute is a charitable organisation that relies on 
philanthropy and public donations to continue its important work. 
The Institute has been fortunate enough to receive the long-running 
support of some great local philanthropists including its Founding 
Benefactor Bob Ingham AO and Lady (Mary) Fairfax (AC, OBE).

• The Ingham Institute is privileged to partner with the University of 
New South Wales (UNSW), the University of Western Sydney (UWS) 
and the South Western Sydney Local Health District (SWSLHD).

• The Ingham lnstitute’s research precinct comprises of the latest 
state of the art facilities including a five-storey Research Building, 
a Clinical Skills & Simulation Centre and a Research Bunker 
containing the MRI-Linac, unique Australian-first cancer therapy 
technology at the Ingham Institute.

• The Clinical Skills & Simulation Centre provides an educational hub 
for researchers, students and clinicians from the South Western 
Sydney Local Health District (SWSLHD), the University of Western 
Sydney (UWS) and the University of New South Wales (UNSW) to 
collaborate and work together.

• The Ingham lnstitute’s mission is to improve the health and 
wellbeing of the local community and wider Australia by creating 
hope through health research.

What type of research is 
being conducted?

The Ingham lnstitute’s work includes both wet 
(laboratory-based) and dry (health and clinical) 
research. Research at the Ingham Institute is 
divided into the following six research streams, 
all targeted towards disease areas affecting the 
local community:

Each of our streams place an emphasis on 
‘translational research’ - taking the results from 
the laboratory, to the clinician and right through to 
the community to improve the health of the local 
and Australian population.

Fact Sheet

What is the  
Ingham Institute 
for Applied Medical 
Research? 

CANCER

CLINICAL SCIENCE 
Comprising cardiovascular disease and 
infectious and inflammatory diseases

COMMUNITY AND 
POPULATION HEALTH

EARLY YEARS /  
CHILDHOOD HEALTH 

INJURY AND REHABILITATION 

MENTAL HEALTH

Typography Examples
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NEUTRALS

This palette has been selected for body copy. 

Colour Palettes

The Ingham Institute corporate color palette is bright 
and fresh— reinforcing a sense of energy and trust 
for all of our brand communications.

Tips 

• Pantone©300 should always be used for 
subheads

• Pantone©432 should generally be used for all 
other copy

Pantone© 300
C100 M40 Y0 K0
R0 G125 B197
#007DC5

Pantone© 299
C70 M15 Y0 K0
R39 G170 B225
#27AAE1

Pantone© 381
C25 M0 Y100 K0
R203 G219 B42
#CBDB2A

C0 M0 Y0 K0
R255 G255 B255
#FFFFFF

Pantone© 432
C25 M0 Y0 K82
R58 G76 B86
#3A4C56

80% tint 50% tint 30% tint

Pantone© 325
C57 M7 Y23 K0
R105 G188 B196
#69BCC4

Pantone© 108
C1 M10 Y100 K0
R255 G232 B0
#FFE800

For UNSW  
co-brand only

Pantone© 281
C100 M85 Y5 K20
R0 G38 B100
#233D7E

For SWSLHD  
co-brand only

Pantone© 201
C7 M100 Y68 K32
R157 G34 B53
#990033

For WSU 
co-brand only

Pantone© 158
C1 M65 Y100 K0
R230 G94 B38
#E65E26

PRIMARY COLOURS

The blues and lime green plays a distinctive role in establishing our identity and should be implemented across 
all communications.

SECONDARY COLOURS

The secondary colours should be used as accent colours for items such as sidebars, charts, graphs. Limit the 
number of secondary colours used in a single piece to not overpower the primary palette. 
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Co-branding - Ingham Institute

Whilst the Ingham Institute actively pursues 
partnerships with academic and research institutes, 
it is important to maintain a consistent association 
with our brand. The Ingham logo must always have 
presence on co-branded material.

Clear space

To properly stage each cobrand logo, the minimum 
distance between each logo should be ‘1/3X’ 
which is equivalent to one third of the height of the 
transformation symbol.

Minimum size

The minimum width of the logo must be at least  
180 pixels for digital applications or 40mm for print. 

Tips 

DO

• Ensure there is '1/3X' space around the cobrand 
logo

• Separate each logo using a grey line separator
• Order each research stream in alphabetical order

X

Y

Y

1/3 X1/3 X

1/3 X
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Co-branding - Logo Lockups

The lockups shown illustrate how the Ingham 
Institute logo and a partner logo can be used 
together.

Note

These are examples for guidance only when a simple 
co-branding application is needed. 

Please work contact the marketing department to 
incorporate the proper alliance partner logos.
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Colour

South West Sydney Local Health District co-branded 
material are indicated as a thin strip at the top of the 
document using Pantone©281. 

Resources 

The SWSLHD logo is available from the Ingham 
Institute Intranet.

<Link>

Please refer to the NSW Health brand guidelines for 
more information, or contact the Marketing team to 
ensure compliance with both brands. 

DRAFT

Co-branding - South West Sydney Local Health District

PANTONE© 281
C100 M85 Y5 K20
R0 G38 B100
#233D7E
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Colour

UNSW co-branded material are indicated as a thin 
strip at the top of the document using Pantone©108. 

Resources 

The UNSW logo is available from the Ingham 
Institute Intranet.

<Link>

Please refer to the UNSW brand guidelines for more 
information, or contact the Marketing team to ensure 
compliance with both brands. 

PANTONE© 108
C1 M10 Y100 K0
R255 G232 B0
#FFE800DRAFT

Co-branding - UNSW Sydney
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Colour

WSU co-branded material are indicated as a thin 
strip at the top of the document using Pantone©201. 

Resources 

The WSU logo is available from the Ingham Institute 
Intranet.

<Link>

Please refer to the WSU brand guidelines for more 
information, or contact the Marketing team to ensure 
compliance with both brands. 

Co-branding - Western Sydney University

PANTONE© 108
C1 M10 Y100 K0
R255 G232 B0
#FFE800DRAFT
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Iconography

Icons can be used as an effective way to convey 
ideas and actions while reflecting our brand. They 
should be simple and clear and treating our symbols, 
icons, graphs, and charts in a standardised way 
ensures an aesthetic consistency at all levels of 
communication.

Sizing Guidelines

When using a Pictogram as a primary or secondary 
design element in a communication, it shouldn’t be 
smaller than 12.5mm.

Tips 

DO

• Add a clearance space of at least half the  
width of the icon

• Create logos with 1pt stroke weight 
• Use the colour palette for the lines in the icons 

and symbols

DON'T

• Compress, stretch or distort
• Rotate the icons
• Add additional elements to the icons

DRAFT
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Photography
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Photography

In order to reflect the Institute’s research, teams, 
facilities and work life, it is vital to use imagery 
that supports the Institute’s values and vision 
in conveying our mission to inspire health and 
transform care.

In order to maintain consistency, all brand imagery 
should follow the basic guidelines and themes.

Research Streams

1. Cancer Stream 
Location: MRI Room, Liverpool Hospital 
Lighting: Warm

2. Clinical Science Stream 
Location: Wet Laboratory, Level 4 and 5,  
Ingham Institute 
Lighting: Florescent

3. Population & Health Services Stream 
Location: Level 4 Balcony, Ingham Institute 
Lighting: Natural

4. Injury & Rehabilitation Stream 
Location: Boardroom 1, Ingham Institute 
Lighting: Dark

5. Mental Health Research 
Location: Level 1, Ingham Institute 
Lighting: Warm

1

4

2

5

3
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Photography

Research Groups
In order to maintain consistency, research group photos are to be taken in the same location as per their research stream.

Individual Photos
In order to maintain consistency, individual photos are to be taken in the same location as per their research stream and group.
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Photography
Facilities
A range of professional photos of the Institute’s world-class facilities and equipment is available by the marketing department. Images of facilities should include a team 
member/s within the photo utilising the equipment where possible.

Collaboration
The Ingham Institute is home to over 300 researchers, scientists and medical professionals from the South West Sydney Local Health District, Western Sydney University 
and University of New South Wales working together to transform health care in our community and beyond.
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Photography

Public Relations

Ingham Institute is a non-for-profit organisation that relies on the support of the community. This includes a variety of events such as charity golf days, fundraising 
walks and ladies luncheon. The Institute also hosts industry events such research showcases and symposiums. A range of images is available upon request through 
the marketing department.
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Applications
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Stationery

Letterhead

1. Horizontal logo 
Full colour wth typefont

2. Vision

3. Company Name 
Accord Alternate Regular, 12pt, Dark Grey

4. ABN 
Accord Alternate Regular, 7pt, Dark Grey

5. Address/Contact details 
Accord Alternate Regular, 9pt, Dark Grey

6. Website address 
Accord Alternate Regular, 12pt, Dark Grey,  
Lowercase

Resources 

Electronic (Word) templates are available via the 
Ingham Institute intranet. <Link>

Dear John,

Maecenas finibus velit ligula, iaculis vulputate massa efficitur luctus. Praesent tincidunt sit amet 
ex quis varius. Suspendisse sit amet tincidunt urna. Nullam elementum accumsan lorem dictum 
dignissim. Vestibulum iaculis sapien at turpis volutpat pretium. Vivamus sollicitudin libero justo. 
Proin eleifend ut velit ac convallis. Donec vitae gravida lectus. Mauris eu ex ac mauris convallis 
elementum.

Nam luctus dictum diam a faucibus. Aliquam blandit orci non est vestibulum porttitor. Sed 
massa arcu, hendrerit vitae pharetra et, iaculis eu ante. Phasellus fringilla sit amet ipsum sed 
porttitor. Phasellus eu lorem dapibus, condimentum lorem a, porta nisi. Proin sagittis ut lorem 
ut euismod. Nunc ut eleifend ante. Sed elit metus, fermentum eget laoreet at, tempus et lectus. 
Etiam ullamcorper orci non erat faucibus, non convallis turpis consequat. Pellentesque non quam 
non arcu euismod aliquet ut eget lorem. Sed congue orci nunc. Nulla et imperdiet est, ut iaculis 
eros. Nulla bibendum vitae leo nec gravida. Aliquam ut enim malesuada, congue nunc fringilla, 
sollicitudin risus.

Orci varius natoque penatibus et magnis dis parturient montes, nascetur ridiculus mus. Ut ipsum 
nisl, lobortis et congue vel, rhoncus sed arcu. Ut vehicula consequat dui at pulvinar. Ut diam 
libero, accumsan sollicitudin faucibus nec, fringilla ut turpis. Donec sodales blandit diam quis 
faucibus. Nullam in varius diam. Proin at nunc est.

Kind Regards,

Ellie Pavlov 
Marketing Executive 
Ingham Institute

Mr John Smith
2-8 Brookhollow Avenue,
Baulkham Hills, NSW, 2153

Ingham Institute 
 ABN 15 958 063 508

1 Campbell Street, Liverpool NSW 2170, Australia 
PO Box 3151, Liverpool NSW 2170, Australia 

P  +61 2 8738 9000   |   F  +61 2 9602 3221 
E  research@inghaminstitute.org.au

inghaminstitute.org.au

Inspiring health. Transforming care. 

1

2

4

3

6

5
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Stationery

Letterhead – Personalised  
(Word template)

1. Horizontal logo 
Full colour wth typefont

2. Vision

3. Name 
Tahoma Regular, 12pt, Dark Grey

4. Position/Contact details 
Tahoma Regular, 9pt, Dark Grey

5. Address 
Tahoma Regular, 8pt, Dark Grey

6. Website address 
Tahoma Regular, 11pt, Dark Grey, Lowercase

Resources 

Electronic (Word) templates are available via the 
Ingham Institute intranet. <Link>

Kelsey Dobell-Brown 
Clinical Trials Manager – Ingham Institute/SWSLHD 

TransCelerate Accredited GCP Trainer 
Direct  +61 2 8738 9150 

E  kelsey.dobellbrown@inghaminstitute.org.au 

Ingham Institute - ABN 15 958 063 508 

1 Campbell Street, Liverpool NSW 2170, Australia 
PO Box 3151, Liverpool NSW 2170, Australia 
P  +61 2 8738 9000  |  F  +61 2 9602 3221 

E  research@inghaminstitute.org.au

inghaminstitute.org.au

Dear John,

Maecenas finibus velit ligula, iaculis vulputate massa efficitur luctus. Praesent tincidunt sit amet 
ex quis varius. Suspendisse sit amet tincidunt urna. Nullam elementum accumsan lorem dictum 
dignissim. Vestibulum iaculis sapien at turpis volutpat pretium. Vivamus sollicitudin libero justo. 
Proin eleifend ut velit ac convallis. Donec vitae gravida lectus. Mauris eu ex ac mauris convallis 
elementum.

Nam luctus dictum diam a faucibus. Aliquam blandit orci non est vestibulum porttitor. Sed 
massa arcu, hendrerit vitae pharetra et, iaculis eu ante. Phasellus fringilla sit amet ipsum sed 
porttitor. Phasellus eu lorem dapibus, condimentum lorem a, porta nisi. Proin sagittis ut lorem 
ut euismod. Nunc ut eleifend ante. Sed elit metus, fermentum eget laoreet at, tempus et lectus. 
Etiam ullamcorper orci non erat faucibus, non convallis turpis consequat. Pellentesque non quam 
non arcu euismod aliquet ut eget lorem. Sed congue orci nunc. Nulla et imperdiet est, ut iaculis 
eros. Nulla bibendum vitae leo nec gravida. Aliquam ut enim malesuada, congue nunc fringilla, 
sollicitudin risus.

Orci varius natoque penatibus et magnis dis parturient montes, nascetur ridiculus mus. Ut ipsum 
nisl, lobortis et congue vel, rhoncus sed arcu. Ut vehicula consequat dui at pulvinar. Ut diam 
libero, accumsan sollicitudin faucibus nec, fringilla ut turpis. Donec sodales blandit diam quis 
faucibus. Nullam in varius diam. Proin at nunc est.

Kind Regards,

Kelsey Dobell-Brown

Mr John Smith
2-8 Brookhollow Avenue,
Baulkham Hills, NSW, 2153

Inspiring health. Transforming care. 

1

2

4

3

6

5
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Stationery

With Compliments Slip

Resources 

Please contact the marketing team. 

With Compliments

1 Campbell Street,  

Liverpool NSW 2170, Australia

PO Box 3151,  

Liverpool NSW 2170, Australia

P  +61 2 8738 9000   |   F  +61 2 9602 3221 

E  research@inghaminstitute.org.au

ABN 15 958 063 508

inghaminstitute.org.au

Inspiring health. Transforming care. 
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Stationery

Envelopes – DL and C4

Resources 

Envelope templates are available via the Ingham 
Institute intranet. <Link>

PO Box 3151,  
Liverpool NSW 2170, Australia

Inspiring health. Transforming care. 

PO Box 3151,  
Liverpool NSW 2170, Australia

Inspiring health. Transforming care. 
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Stationery

Business Cards – Ingham Institute

Resources 

Please contact the marketing team to order your 
business cards. 

Inspiring health. Transforming care. 

P   +61 2 8738 9000  M +61 459 257 256 
F   +61 2 9602 3221 E ellie.pavlov@inghaminstitute.org.au

inghaminstitute.com.au

1 Campbell Street, Liverpool NSW 2170, Australia

Ellie Pavlov 
Marketing Executive
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Stationery

Co-branded Business Cards – SWSLHD

Resources 

Please contact the marketing team to order your 
business cards. 

Inspiring health. Transforming care. 

Clinical Trials Support: southwestsydneyresearch.org.au

P   +61 2 8738 9016  M +61 430 133 589 
F   +61 2 9602 3221 E kelsey.dobell-brown@sswahs.nsw.gov.au

inghaminstitute.com.au

1 Campbell Street, Liverpool NSW 2170, Australia

Kelsey Dobell-Brown
Clinical Trials Manager  
Ingham Institute/SWSLHD  |  TransCelerate Accredited GCP 

PROPOSED
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Stationery

Co-branded Business Cards – UNSW

Resources 

Please contact the marketing team to order your 
business cards. 

Inspiring health. Transforming care. 

P   +61 2 8738 9016  M +61 430 133 589 
F   +61 2 9602 3221 E john@exampledomain.com.au

inghaminstitute.com.au

1 Campbell Street, Liverpool NSW 2170, Australia

Professor Minoti Apte OAM
Editor-in-Chief, Pancreatology  |  Director, Pancreatic Research Group 
Faculty of Medicine, UNSW  |  Ingham Institute  |  Liverpool Hospital

PROPOSED
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Stationery

Co-branded Business Cards –  
Western Sydney University

Resources 

Please contact the marketing team to order your 
business cards. Inspiring health. Transforming care. 

P   +61 2 8738 9016  M +61 430 133 589 
F   +61 2 9602 3221 E john@exampledomain.com.au

inghaminstitute.com.au

1 Campbell Street, Liverpool NSW 2170, Australia

Slade Jensen 
Associate Professor, Infectious Diseases and Microbiology | School of Medicine 
Antibiotic Resistance and Mobile Elements Group | Ingham Institute

PROPOSED
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Email Signatures - Ingham Institute

Consistent use of our electronic Microsoft Outlook 
email signatures will contribute to a consistent 
brand language and a common voice with our 
outside customers.

Email signatures should never be created by individuals.

Fonts

Typefaces, colors, hyperlinks and graphics have been 
carefully chosen to be consistent with our visual 
identity.

All default fonts in Microsoft Outlook should be 
set to Tahoma Regular, font size 10 for brand 
consistency. 

Instructions (Outlook 2007) 

1. Tools > Options > Mail Format > Stationery and 
Fonts

2. Under “New Mail Messages” click on Font
3. Select Tahoma/Regular/10, then click OK
4. Repeat step 3 for “Replying or forwarding 

messages”
5. Click OK 

Resources 

Email signature templates are available via the 
Ingham Institute intranet. <Link>

PROPOSED

Stationery
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Co-branded Email Signature – SWSLHD

Typefaces, colors, hyperlinks and graphics have been 
carefully chosen to be consistent with our visual 
identity.

All default fonts in Microsoft Outlook should be 
set to Tahoma Regular, font size 10 for brand 
consistency. 

Instructions (Outlook 2007) 

1. Tools > Options > Mail Format > Stationery and 
Fonts

2. Under “New Mail Messages” click on Font
3. Select Tahoma/Regular/10, then click OK
4. Repeat step 3 for “Replying or forwarding 

messages”
5. Click OK 

Resources 

Email signature templates are available via the 
Ingham Institute intranet. <Link>

PROPOSED

Stationery
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Co-branded Email Signature – UNSW

Typefaces, colors, hyperlinks and graphics have been 
carefully chosen to be consistent with our visual 
identity.

All default fonts in Microsoft Outlook should be 
set to Tahoma Regular, font size 10 for brand 
consistency. 

Instructions (Outlook 2007) 

1. Tools > Options > Mail Format > Stationery and 
Fonts

2. Under “New Mail Messages” click on Font
3. Select Tahoma/Regular/10, then click OK
4. Repeat step 3 for “Replying or forwarding 

messages”
5. Click OK 

Resources 

Email signature templates are available via the 
Ingham Institute intranet. <Link>

PROPOSED

Stationery
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Co-branded Email Signature –  
Western Sydney University

Typefaces, colors, hyperlinks and graphics have been 
carefully chosen to be consistent with our visual 
identity.

All default fonts in Microsoft Outlook should be 
set to Tahoma Regular, font size 10 for brand 
consistency. 

Instructions (Outlook 2007) 

1. Tools > Options > Mail Format > Stationery and 
Fonts

2. Under “New Mail Messages” click on Font
3. Select Tahoma/Regular/10, then click OK
4. Repeat step 3 for “Replying or forwarding 

messages”
5. Click OK 

Resources 

Email signature templates are available via the 
Ingham Institute intranet. <Link>

PROPOSED

Stationery
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Presentation Template

It is important to project a consistent image of 
the Institute through our internal and external 
communications. The presentation template 
should be used for all electronic presentations.

Printing Tip 

When printing 16:9, choose “Scale to fit paper” from 
print dialogue. This will ensure the whole slide is 
printed on your selected paper size. 

Stationery
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Co-branded Presentation Template – 
UNSW

It is important to project a consistent image of 
the Institute through our internal and external 
communications. The presentation template 
should be used for all electronic presentations.

The UNSW co-branded presentationtemplate 
is identified by the yellow strip at 
the top of the document. 

Printing Tip 

When printing 16:9, choose “Scale to fit paper” from 
print dialogue. This will ensure the whole slide is 
printed on your selected paper size. 

Stationery

PROPOSED
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Co-branded Presentation Template – 
Western Sydney University

It is important to project a consistent image of 
the Institute through our internal and external 
communications. The presentation template 
should be used for all electronic presentations.

The Western Sydney University co-branded 
presentation template is identified by the 
red strip at the top of the document. 

Printing Tip 

When printing 16:9, choose “Scale to fit paper” from 
print dialogue. This will ensure the whole slide is 
printed on your selected paper size. 

Stationery

PROPOSED



Inspiring health. Transforming care. 


